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  83

In this section:

Using Formulas 
and Functions

Microsoft Excel 2010 workbooks allow you to do much more 
than simply store and organize your data. One important 

task you can perform in Excel is to summarize the values in 
related cells. Whether those cells represent the sales for a day at 
your store, the returns from your personal investments, or your 
times in bicycle races, you can find the total or average of the 
values, identify the minimum or maximum value in a group, or 
perform dozens of other calculations on your data. Many times 
you can’t access the information you want without referencing 
more than one cell; it’s also often true that you’ll use the data 
in the same group of cells in more than one calculation. Excel 
makes it easy to reference a number of cells at once, letting you 
build your calculations quickly.

6
■■ Understanding Formulas and Cell 

References in Excel

■■ Creating and Editing Formulas

■■ Creating, Editing, and Deleting Named 
Ranges

■■ Using Named Ranges in Formulas

■■ Summarizing the Values in Groups of 
Cells

■■ Creating Formulas That Reference 
Cells in Other Workbooks

■■ Summing with Subtotals and Grand 
Totals

■■ Exploring the Excel Function Library

■■ Creating Conditional Functions

■■ Debugging Your Formulas



Understanding Formulas and Cell 
References in Excel
After you add your data to a worksheet, you can summarize 
the data by creating formulas. A formula is an expression that 
performs calculations on your data. For example, in a worksheet 
that lists hourly sales for a day in a single row of cells, you can 
build a formula in the last cell in that row to find the total of all 
sales for the day. You can also build the formula to calculate the 
average or find the lowest or highest hourly value. 

When you build a formula, you need to identify the work-
sheet cells that provide the values for the formula and the opera-
tions you want to perform on those values. To identify a cell, you 
give its cell reference. The first cell in the first column is cell A1, 
meaning column A, row 1. If you examine a formula, you some-
times see a cell reference written as $A$1, rather than just A1. 
The difference is that cell references written with the dollar signs 
are absolute references, meaning the reference doesn’t change 
when the formula is copied to another cell. Cell references written 
without the dollar signs are relative 
references, which do change when 
the formula with the references is 
copied to another cell.

The benefit of relative ref-
erences is that you can write a 
formula once, copy it to as many 
other cells as you like, and have 
Excel update the formulas to 
reflect the new cells. As an exam-
ple, consider the worksheet in the 
following figure, which tracks the 
number of hourly package pick-
ups for a month.

The cells in column P contain 
formulas that calculate the sum of 
the hourly pickup values in column 

C through column O. The formula in cell P5, =SUM(C5:O5), finds 
the sum of cells in row 5, corresponding to January 1. When you 
copy the formula from cell P5 to cell P6, the formula changes 
to =SUM(C6:O6). Excel notices that you copied the formula to 
a new row and assumes that you want the formula to work on 
that data. Had you written the formula as =SUM($C$5:$O$5), 
however, Excel would notice that the formula used absolute ref-
erences and would copy the formula as =SUM($C$5:$O$5).

If you want to reference a value from a cell in another 
workbook, you can do that. Excel uses 3D references, which 
means that any cell in any workbook can be described by 
three pieces of information:

•	 The name of the workbook

•	 The name of the worksheet

•	 The cell reference

Here’s the reference for cell 
Q38 on the January worksheet in 
the Y2010ByMonth workbook:

[Y2010ByMonth.xlsx] 
        January!$Q$38

The good news is that you 
don’t need to remember how to 
create these references yourself. 
If you want to use a cell from 
another workbook in a formula, 
all you need to do is click the cell 
where you want to use the value, 
start the formula, and then click 
the cell in the other workbook. 
Excel fills in the reference for you.
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Creating Simple Cell Formulas 
Building calculations in Excel is pretty straightforward. If you 
want to find the sum of the values in two cells, you just type an 
equal sign (=), the reference of the first cell, a plus sign (+), and 

the reference of the second cell. The formula you enter appears 
on the formula bar, where you can examine and edit it.

Build a Formula

1	 Click the cell in which you want to enter a 
formula.

2	 Type =.

3	 Type the expression representing the cal-
culation you want to perform. 

4	 Press Enter.

Click the Excel Help button.  Then, in the Excel Help 
dialog box, type common formulas in the Search 
box, press Enter, and click Examples Of Commonly 
Used Formulas in the list of available topics. The Help 
file that appears has quite a few examples of formu-
las you might want to create.

Try This!

Be sure that there’s no space before the equal 
sign in your formula. If there is, Excel interprets 
the cell’s contents as text, not a formula.

Caution

Edit a Formula

1	 Click the cell you want to edit.

2	 Select the part of the formula you want to 
edit in the formula bar.

3	 Make any changes that you want.

4	 Press Enter. 

1 2

3
2

1
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Create a Named Range

1	 Select the cells you want to name.

2	 Click the Name Box on the Formula Bar.

3	 Type the name you want for the range.

4	 Press Enter.

Go to a Named Range

1	 Click the Name Box down arrow.

2	 Click the range to which you want to go.

Assigning Names to Groups of Cells 
When you work with large amounts of data, it’s easy to lose 
track of which cells contain which data. In addition, it can 
be difficult to locate data in workbooks you didn’t create. 
Although you might always store product prices in one work-
sheet column, there’s no guarantee that your colleagues will 
follow the same pattern! One way to prevent confusion is to 

define a named range for any cell group that holds specific 
information. For example, in a worksheet with customer order 
data, you can define the Totals named range to represent 
the cells in which the total for each order is stored. After you 
define the named range, you can display its contents, rename 
it, or delete it.

For information about selecting cells from several parts of the 
same worksheet, see “Select a Noncontiguous Group of Cells” 
on page 32.

See Also

The name you give your named range shouldn’t duplicate a 
potential cell address. For example, typing DAY1 in a formula 
would reference cell DAY1. To avoid this problem, either ensure 
that your ranges have names that begin with at least four let-
ters (the last column is XFD) or use an underscore to separate 
the letters from the rest of the name. The name DAY1 isn’t 
valid, but the name DAY_1 is.

Caution

3 2

1
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Delete a Named Range

1	 Click the Formulas tab.

2	 Click Name Manager.

3	 Click the named range you want to delete.

4	 Click Delete.

5	 Click OK to clear the confirmation dialog 
box that appears.

6	 Click Close.

Rename a Named Range

1	 Click the Formulas tab.

2	 Click Name Manager.

3	 Click the named range you want to 
rename.

4	 Click Edit.

5	 Type a new name for the range.

6	 Click OK.

7	 Click Close.

6

5
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Create a Formula with a Named Range

1	 Click the cell in which you want to enter a formula.

2	 Type = followed by the formula you want. When 
you want to use a range that has a name, start 
typing the name instead of the cell address.

3	 Click the named range in the Formula AutoComplete 
list that appears.

4	 Press Enter.

 

Using Names in Formulas 
When you define a named range, you create a shortcut that 
you can use to refer to a group of cells. A great way to use 
named ranges is in formulas. Instead of entering the refer-
ences of every cell you want to use in your calculation, you 
can type the name of the range. When you reference named 
ranges in formulas, your formulas are shorter and easier to 
understand. Rather than seeing a series of cell references you 
need to examine, you and your colleagues can rely on the 
named ranges to understand the goal of a calculation.

Excel 2010 further streamlines formula creation with  
Formula AutoComplete. Remember that when you start typing 
a value into a cell, Excel examines the previous values in that 
column and offers to let you complete the entry by pressing 
Tab or Enter. Now, when you start typing a named range’s 
name into a formula, Excel recognizes that you might be 
entering a named range and displays a list of named ranges 
(as well as built-in functions) available in the active workbook. 
All you have to do is click the named range you want, and it’s 
included in the formula immediately.

If you change the name of a range of cells, Excel 
automatically makes the name change in every 
one of your formulas.

Tip

3
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Create a Formula with an Excel Table Reference

1	 Click the cell in which you want to create the 
formula.

2	 Type =, followed by the function to include in the 
formula and a left parenthesis; for example, =SUM( 
would be a valid way to start.

3	 Type the name of the Excel table.

4	 Type a left square bracket.

5	 Click the name of the table column.

6	 Type a right square bracket, a right parenthesis, and 
press Enter.

Creating a Formula That References 
Values in an Excel Table
In previous versions of Excel, it was a challenge to create 
named ranges that included an entire column in a data list. 
Suppose that you created a named range that encompassed 
the existing cells in a data column, such as the cell range 
A3:A44; if you added data to cell A45, you would need to 
change the cells in the named range’s definition. Yes, there is 

a complicated way to create a dynamic named range in Excel 
2003 and earlier versions, but you don’t have to worry about 
it in Excel 2010. All you need to do is create an Excel table 
(as shown in “Creating an Excel Table” on page 41) and select 
the headers of the columns that contain the data you want to 
summarize in your formulas.

To include more than one table column in a formula, either 
hold down the Shift key, select the column header of the first 
column to use in the formula, and then click another column 
to select everything in the span between the two columns, or 
hold down the Ctrl key and click the other column headers you 
want to use. Excel includes the references in the formula.

Tip
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Use Cells from Other Workbooks in a Formula

1	 Open the workbook with the cell you want to 
reference in your formula.

2	 In the workbook where you want to create the 
formula, click the View tab.

3	 Click Arrange All.

4	 Select the Tiled option.

5	 Click OK.
(continued on next page)

Creating Formulas That Reference Cells in 
Other Workbooks
One of the strengths of Excel is that you aren’t limited to using 
cells from the current workbook in your formulas. If you want, 
you can use data from any other workbook in your calculations. 
For example, you might have a workbook in which you track 
monthly advertising sales for your newsletter. If you want to 
create a new workbook to summarize all income and expenses 
for your publication, you can do so. By letting you create 
formulas that reference cells from more than one workbook, 
Excel makes it easy for you to organize your workbooks so that 

each workbook holds data about a specific subject. Not only 
can you find the data easily, you can reference it anywhere 
else.

After you create links between workbooks, you can have 
Excel update your calculation if the data in the linked cell 
changes. You can also change the cell to which you linked, or 
if the workbook with the cell to which you linked has been 
moved or deleted, you can delete the link and have Excel store 
the last value from the calculation.

5
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Use Cells from Other Workbooks in 
a Formula  (continued)

6	 Click the cell where you want to 
create the formula.

7	 Type = followed by the first part of 
the formula.

8	 Select the cells with the values you 
want to use in the formula.

9	 Press Enter.

Break Links to Other Workbooks 
and Convert to Values

1	 Click the cell that contains the 
formula you want to edit.

2	 Select the part of the formula repre-
senting the link you want to break.

3	 Press F9.

4	 Press Enter.

 

You can use the techniques here to link to a cell 
on a different worksheet in the same workbook. 
Just create the formula, and when you want to 
put in the cell reference, move to the target 
worksheet and click the appropriate cell.

Tip

6

8

7
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Refresh Links

1	 Click the Data tab.

2	 In the Connections group, click 
Refresh All.

 

Change Links to Different 
Workbooks

1	 Click the Data tab.

2	 In the Connections group, click Edit 
Links.

3	 Click the link you want to change.

4	 Click Change Source.

5	 Click the workbook with the new cell 
to which you want to link.

6	 Click OK.

7	 Select the sheet from which to 
update values.

8	 Click OK.

9	 Click Close.

2 1
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Summarize Data in a Group of Cells

1	 Select the cells you want to 
summarize.

Find the Total, Average, or Other 
Values of Cell Data

1	 Right-click the status bar, and choose 
the summary operations you want 
from the shortcut menu.

Summing a Group of Cells Without Using 
a Formula
Sometimes, such as when you’re entering data into a work-
sheet or you’re curious to find out the sum or average of the 
values in a few cells, it’s too much work to find a blank cell 
and write a formula to calculate the sum or average for the 
cells. Rather than make you create a separate formula, Excel 
counts the number of cells selected, calculates a running total 

and average for the currently selected cells, and displays the 
results on the status bar. Finding the sum, average, and count 
of the values in the selected cells are the most commonly used 
operations, so Excel calculates those values by default. You can 
choose from several other operations, however, or even tell 
Excel not to calculate a running total for any selected cells.

Active summary operations are checked 
on the shortcut menu. Clicking a checked 
summary operation turns off that 
operation.

Tip

1

The summary operations 
and results of the

summaries appear 
on the status bar

1

Summing a Group of Cells Without Using a Formula  93

Using Formulas and Functions



Create an AutoSum Formula

1	 Click the cell where you want the summary 
value to appear.

2	 Click the Home tab.

3	 Click the AutoSum down arrow.

4	 Click the AutoSum function you want to use.

5	 If necessary, select the cells with the data you 
want to summarize.

6	 Press Enter.

Creating a Summary Formula
After you enter data into a worksheet, you can create formulas 
to summarize the values and display the result of the calcula-
tion. You can summarize the values in a group of cells in many 
ways: You can find the total or average of the cell values, iden-
tify the maximum or minimum value in the group, or simply 
count the number of cells containing values. You can create 
these formulas by clicking the cell below or to the right of the 
cells you want to summarize, displaying either the Home tab 

or the Formulas tab, and clicking the AutoSum button. (The 
button appears on both tabs.) Clicking the AutoSum button 
itself creates a SUM formula, which finds the arithmetic sum of 
the values, but you can choose other calculations by clicking 
the AutoSum button’s down arrow. After you create the for-
mula you want, you can use the result in other calculations.

For information about finding a running total for a group of 
cells without creating a formula, see “Summing a Group of Cells 
Without Using a Formula” on page 93.

See Also

1
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Create a Subtotal

1	 Click any cell in the range you want 
to subtotal.

2	 Click the Data tab.

3	 In the Outline group, click Subtotal.

4	 Click the At Each Change In down 
arrow.

5	 Click the value on which you want to 
base the subtotals.

6	 Click the Use Function down arrow.

7	 Click the subtotal function you want 
to use.

8	 Select which columns should have 
subtotals calculated.

9	 Click OK.

Summing with Subtotals and Grand Totals 
You frequently need to organize the data in an Excel work-
sheet by one or more criteria. For example, you might have a 
worksheet in which you list yearly sales for each product you 
offer, with the products broken down by category. If your data 
is organized this way, you can have Excel calculate a subtotal 

for each category of products. When you create a subtotal, 
you identify the cells with the values to be calculated and the 
cells that identify the change from one category to the next; 
Excel updates the subtotal and grand total for you if the value 
of any cell changes.

1 2 5 4 3
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Remove a Subtotal

1	 Click any cell in the subtotaled range.

2	 Click the Data tab.

3	 Click Subtotal.

4	 Click Remove All.

1 2 3
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List Functions Available from the 
Excel Library

1	 Click the Insert Function button.

2	 Display the drop-down list, and click 
the function category you want to 
view.

3	 Click the function you want to 
examine.

4	 Click OK.

5	 Click Cancel to close the Function 
Arguments dialog box.

1 2

4

3

5

Exploring the Excel Function Library
You can create dozens of different functions in Excel. You can 
use Excel functions to determine mortgage payments, perform 
scientific calculations, or find the square root of a number. 
The best way to become familiar with the formulas available 
in Excel is to display the Insert Function dialog box and move 
through the listed functions, clicking the ones that look inter-
esting. When you click a function, its description appears at 
the bottom of the dialog box.

Another way to get information about a function is to 
view the ScreenTip that appears next to the function. If you 
double-click a cell with a function, a ScreenTip with the func-
tion’s structure and expected values appears below it. Clicking 
an element of the structure points to the cell or cells providing 
that value.
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Use Function ScreenTips

1	 Double-click a cell that contains a formula.

2	 In the ScreenTip, click the function name to 
open the Help file entry for the function.

3	 Click the Close button to close the Help 
window.

4	 Click an argument to select the cells to 
which it refers.

3
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Create an IF Function

1	 Click the cell in which you want to 
enter an IF function.

2	 Click the Formulas tab.

3	 Click Logical.

4	 Click IF.

5	 Type a conditional statement that 
evaluates to true or false.

6	 Type the text you want to appear if 
the condition is true.

7	 Type the text you want to appear if 
the condition is false.

8	 Click OK.

3 2
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Using the IF Function
In addition to calculating values based on the contents of 
other cells, you can have Excel take different actions based on 
the contents of those other cells by using the IF function. For 
example, if you create a workbook to track the times of riders 
in a bicycle-racing club, you can create a formula to compare 

each rider’s time to his previous time. When someone’s most 
recent time is the lowest time in the group, you can have Excel 
display Personal Best in the cell with the formula, alerting you 
to congratulate the rider in your next club newsletter.

The text message must be enclosed in quotation marks.

Caution You can also create an expression in the Value_If_True and 
Value_If_False boxes. Excel displays the result of the expression 
in the appropriate box.

Tip
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Find Cell Precedents and Dependents

1	 Click the cell you want to examine.

2	 Click the Formulas tab.

3	 Using the controls in the Formula Auditing 
group, follow either of these steps:

•	 Click Trace Precedents.

•	 Click Trace Dependents.

2 3

1

Checking Formula References
When you create a formula that draws values from several dif-
ferent places in your workbook—or from other workbooks—it 
can be difficult to see what’s going wrong if your formula isn’t 
producing the expected results. Excel helps you locate a cell’s 
precedents (the cells the formula uses in its calculation) and 

dependents (the cells that depend on the current cell to cal-
culate their own values). To help you find what you need to 
check your formulas, Excel groups all the tools you need on 
the Formula Auditing group on the Formulas tab.
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Tracer arrows are particularly effective when they’re used to 
examine formulas that include named ranges. When you refer 
to a named range, you know what the indicated cells are sup-
posed to represent.

Tip

Remove Tracer Arrows

1	 Click the Formulas tab.

2	 Click the Remove Arrows down arrow, 
and follow any of these steps:

•	 Click Remove Arrows to remove all 
arrows.

•	 Click Remove Precedent Arrows to 
remove the precedent arrows.

•	 Click Remove Dependent Arrows to 
remove the dependent arrows.

1 2
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Monitor a Formula for Changes

1	 Click the Formulas tab.

2	 Click Watch Window.

3	 Click Add Watch.

4	 Select the cells you want to watch.

5	 Click Add.

6	 Click Watch Window.

1 3 2 6
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Debugging Your Formulas
When you share a workbook with your colleagues, some of 
the values in that workbook might change rapidly as new data 
is entered. For example, workbook data probably will change 
quickly if you are evaluating stock prices. Stock market values 
change frequently, so your data will as well. You can monitor 
the value in a cell even while you’re using another workbook 
by setting a watch. When you set a watch, the values of the 
cells you’re monitoring appear in the Watch Window.

Another way you can monitor your data is to check the 
result of part of a calculation by using the Evaluate Formula 
dialog box. When you click the Evaluate Formula button, Excel 
displays the formula in the active cell and the subtotal for 
part of the calculation. You can move through the formula bit 
by bit, with Excel showing you the result of each piece of the 
formula.
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Delete a Watch

1	 Click the Formulas tab.

2	 Click Watch Window.

3	 Click the watch you want to delete.

4	 Click Delete Watch.

5	 Click the Close button.

Evaluate Parts of a Formula

1	 Click the cell with the formula you 
want to evaluate.

2	 Click the Formulas tab.

3	 Click Evaluate Formula.

4	 Click Evaluate (one or more times) 
to move through the formula’s 
elements.

5	 Click Close.

1 4 3 2 5
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Index

Numbers
3D charts, 226
3D references, 84
3D rotating objects, 242

A
accepting

Track Changes, 278–279
Access 2010

sharing data between Access tables and 
worksheets, 269

Add Assistant, 255
advanced filters

creating, 205–206
removing, 206

advanced paste options, 51
aligning

drawing objects, 246–248
Align Left button, 119
alignment

cell text, 119
Align Right button, 119
apostrophes

typing numbers as text values, 36
appearance

charts, 215–216
area charts, 212
ascending order

sorting worksheet data, 198
AutoComplete

data entry, 40

AutoCorrect
creating entries, 192–193
deleting entries, 194

AutoFill
inserting data into cells, 39

AutoFilters
creating, 202–204

AutoFormat
controlling rules, 195

AutoSum formula
creating, 94

B
backgrounds

cells, 111, 112
removing from pictures, 245

Backstage view, 2, 6, 156–157
exiting, 19
setting print margins, 164–165

backups
workbooks, 279

bar charts, 212
blank workbooks

creating, 19
starting Excel 2010, 12

blank worksheets
inserting, 67

bodies (chart)
changing, 219–221

borders
cells, 113–114

drawing, 113
Bottom Align button, 119
breaking links, 91
bubble charts, 212

C
calculations, 3, 30, 83, 84

creating SUM formula, 94
formulas

debugging, 102–103
functions, 97–98

IF, 99
grand totals, 95–96
relative references, 84
subtotals, 95–96
summing cells, 93

cascading workbooks, 20
categories

pie charts, 225
cell dependents, 100–101
cell precedents, 100–101
cell references, 10
cells, 10

3D references, 84
active, 10
backgrounds, 111, 112
borders, 113–114

drawing, 113
clearing, 53
comments, 275

deleting, 276
editing, 276
names, 276
viewing, 275

copying
from worksheets to groups of 

worksheets, 77
copying values, 50–51
cutting values, 50–51
deleting, 70

formulas, 147
dragging, 71
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editing, 44
formatting, 105

conditional formatting, 121–125, 126, 
127

copying formats with Format Painter, 
131

dates, 110
deleting conditional formats, 130
fonts, 106
formatting parts of, 107
numbers, 108–109
ranges, 107
text, 107

formulas, 83, 84
creating, 85, 89
creating with cell references, 90–92
editing, 85
names, 88
spaces, 85

inserting data into
multiple worksheets, 76–77

inserting dates into, 37, 38
inserting into worksheets, 70
inserting symbols into, 45
inserting times into, 37, 38
locking, 153
merging, 132–133
moving, 70
numbers

inserting, 36
orienting contents, 119
pasting values, 50–52
ranges

deleting, 87
names, 86–87
validation rules, 209

relative references, 84
selecting, 32–33
shading, 111, 112

splitting, 132–133
styles, 115–118

applying, 115
creating, 116
deleting, 118
modifying, 117

summing, 93
AutoSum formula, 94
grand totals, 95–96
subtotals, 95–96

text
alignment, 119
inserting, 34–35
orienting, 120
wrapping, 120

Track Changes, 277
accepting/rejecting tracked changes, 

278–279
XML, 285

Cell Styles gallery, 116
cells (worksheets)

series, 223
deleting, 224

Center button, 119
Change History

creating, 279
character delimiters, 272
Chart (Linked To Excel Data) option, 268
charts, 211, 212

appearance, 215–216
area, 212
bar, 212
bodies of charts, changing, 219–221
bubble, 212
column, 212
cone, 212
copying data into PowerPoint, 267–268
creating, 213–214
customizing data, 222
cylinder, 212

doughnut, 212
formatting, 216

legends, 217–218
titles, 217–218

gridlines
displaying, 219
hiding, 219

layout, 214
line, 212
organization, 233

creating, 254–257
design, 257
layouts, 256

pie, 212, 225
exploded, 226

pyramid, 212
radar, 212
scale, changing

value axis, 220
X-axis, 221

scatter plot, 212
sparklines, 2, 3

column, 230
line, 229
Win/Loss, 231

stock, 212, 227
styles, 214
surface, 212
trendlines

adding to data series, 228
clearing

cells, 53
filters from lists, 204
Office Clipboard items, 55

clip art
inserting into worksheets, 251

Close Full Screen command, 23
closing

workbooks, 24–25, 25
code (XML), 285
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colors
displaying error messages, 191
gridlines, 140
sheet tabs, 139
themes, 136
WordArt, 250
worksheet tabs, 69

color scales
displaying, 129

Colors dialog box
displaying, 69

column charts, 212
Column heading, 10
columns, 10

deleting, 72–74, 147
displayed grouped columns, 149
grouping, 148–149
headings

printing, 159
hiding, 35, 75, 150–151
hiding grouped columns, 148–149
inserting, 72–74
inserting into worksheets, 144–145
moving, 146

worksheets, 72–74
selecting, 33
sizing, 43, 142–143
tables

creating formulas that reference, 89
ungrouping, 148–149
unhiding, 75, 151
widths

changing in Page Layout View, 157
worksheets

sorting data, 198–199, 199
column sparklines

creating, 230
commands

adding to Quick Access Toolbar, 175, 
179–180

adding to Ribbon, 181
Close Full Screen, 23
icons, 186
removing from Quick Access Toolbar, 180
reordering on Ribbon, 182
shortcut menus, 26–27

comments, 4
deleting, 276
editing, 276
in cells, 275
names, 276
viewing, 275

conditional formats
visualizing data, 7

conditional formatting, 121–125
based formulas, 123
based on values of cells, 121–122
changing order of conditions, 127
deleting conditional formats, 130
deleting rules, 125
editing rules, 124
stopping when conditions are met, 126

cone charts, 212
contiguous cells

selecting, 32–33
Copy As Picture option, 51
copying

cells
from worksheets to groups of 

worksheets, 77
cell values, 50–51
charts into PowerPoint, 267–268
data between Word tables and Excel 

tables, 265–266
styles with Format Painter, 131
Web data to Excel, 283
worksheets, 66

Create Refreshable Web Query option, 283
Create Table dialog box

displaying, 41

Ctrl key
dragging Fill handles, 39

currency
displaying numerical values as, 108

custom equations
adding to shapes, 259

custom groups
creating, 185

customizing
chart data, 222
objects, 243–245
pictures, 243–245
Quick Access Toolbar, 6
Ribbon, 6, 181–188

custom lists
defining, 200–201

custom properties, 18
custom styles

creating, 116
custom tabs

creating, 184
custom views, 81
custom zoom levels, 22
cutting

cell values, 50–51
cylinder charts, 212

D
data

merging, 132–133
pasting

Paste Preview, 6
sharing, 3
splitting, 132–133
summarizing

sparklines, 7
statistical functions, 6

visualizing, 7
conditional formats, 7
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Web

copying to Excel, 283
retrieving using Excel, 282

data bars
displaying, 128

data entry, 3, 29, 30, 34–35
AutoComplete, 40
dates, 30, 37, 38
fractions, 30
lists, 40
multiple worksheets, 76–77
numbers, 36
saving workbooks as templates, 177
series, 39
shortcuts, 40
times, 30, 37, 38
validation, 207–209

data lists
creating tables, 41–43

data refreshes
Web queries, 284

Data Validation dialog box, 209
dates

formatting, 30, 110
inserting into cells, 37–38, 38

debugging
formulas, 102–103

decimal places
setting, 109

defaults
file folders

changing, 25
deleting

AutoCorrect entries, 194
cells, 70

formulas, 147
columns, 72–74, 147
comments, 276
conditional formats, 130

conditional formatting rules, 125
pictures, 235
ranges, 87
rows, 72–74, 147
series, 224
sparklines, 232
styles, 118
watches, 103
worksheets, 67

delimiters, 271, 272
descending order

sorting worksheet data, 198
design

organization charts, 257
diagrams, 233

inserting, 252–253
organization charts, 233
styles, 253
Venn, 233

dialog boxes
Colors, 69
Create Table, 41
Format Cells, 30, 106
Highlight Changes, 279
Insert Hyperlink, 48

directories
saving templates, 177

Display As Icon check box, 263
displaying. See also viewing

chart legends, 217–218
color scales, 129
Colors dialog box, 69
columns, 151
comments, 275
Create Table dialog box, 41
data bars, 128
error messages, 189–191

colors, 191
formula bar contents, 34–35
gridlines, 141, 219

grouped columns, 149
grouped rows, 149
icon sets, 129
math equations, 8
Office Clipboard contents, 54
Pick From Drop-Down List items, 40
Ribbon elements, 188
rows, 151
workbooks, 20
worksheets, 68, 156–157

doughnut charts, 212
dragging

cells, 71
Fill handles, 39

drawing
borders, 113

drawing objects, 234–235
adding to worksheets, 236–237
aligning, 246–248
effects, 241
fills, 238–240
grouping, 246–248
ordering, 248
ungrouping, 247

dynamically updating worksheets, 281

E
editing

cells, 44
conditional formatting rules, 124
formulas, 85
pictures, 8
shadows, 241
styles, 117
templates, 178

effects
drawing objects, 241
text effects

WordArt, 249
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embedding, 262–264
enabling

in-cell editing, 44
Live Preview, 11
Track Changes, 277

equations
adding to shapes, 258–259
math

creating, 8
displaying, 8

error messages, 189–191
colors, 191
resetting ignored messages, 190

Esc key
undoing edits to cells, 44

Evaluate Formula dialog box, 102
Excel 2010

exiting, 25
Help system, 26–27
new features, 5
sharing data between Access tables and 

worksheets, 269
sharing table data with Word tables, 

265–266
starting, 12

Excel Chart (Entire Workbook) option, 268
exiting

Backstage view, 19
Excel, 25

exploded pie charts, 226
exponents

inserting numbers into cells, 36
Extensible Markup Language. See XML

F
fields

Keywords, 17
file folders

changing, 25

file properties
custom properties, 18
finding workbooks, 17–18

files
adding hyperlinks to, 47
embedding, 262–264
linking, 262–264
recently used

viewing, 47
text files

importing, 271
File tab, 5, 6

printing worksheets, 158
Fill handles

dragging, 39
fills

drawing objects, 238–240
inserting data into cells, 39
pictures, 240

filtering
worksheet data

advanced filters, 205–206
AutoFilters, 202–204
clearing filters, 204
creating advanced filters, 205–206
creating search filters, 204
creating selection filters, 202

finding
templates on Office.com Web site, 176
text, 57–58
workbooks, 14–16

file properties, 17–18
Fluent interface, 11
folders

changing, 25
saving templates, 177

fonts
cells, 106

footers
adding graphics to, 171–172

creating, 168–170
formatting, 172
height, 170
previewing, 168
text, 169

Format Cells dialog box, 30, 106
Format Painter, 131
formatting, 11, 107

cell borders, 113–114
cells, 105

conditional formatting, 121–125, 126, 
127

copying formats with Format Painter, 
131

dates, 110
deleting conditional formats, 130
fonts, 106
formatting parts of, 107
numbers, 108–109
ranges, 107
text, 107

charts, 216
legends, 217–218
titles, 217–218

dates, 30
fractions, 30
headers and footers, 172
numbers, 108–109
sparklines, 232
text

footers, 169
headers, 169
in shapes, 237

times, 30
worksheets, 135

coloring sheet tabs, 139
gridlines, 140–141
multiple worksheets, 76–77
protecting worksheets, 152
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formatting, worksheets (continued)
sizing columns/rows, 142–143
themes, 136–138

Formatting option, 51
formula bar

editing cells, 44
scrolling contents of, 34–35

formulas, 3, 83, 84
AutoSum

creating, 94
cell dependents, 100–101
cell precedents, 100–101
conditional formatting, 123
creating, 85

cell references, 90–92
table references, 89

debugging, 102–103
deleting cells, 147
deleting watches, 103
editing, 85
error messages, 189–191
mistakes, 175
names, 88
relative references, 84
removing tracer arrows, 101
saving workbooks as templates, 177
spaces, 85
SUM, 94

Formulas & Number Formatting option, 51
Formulas option, 51
fractions

formatting, 30
freezing panes, 79
Full Screen mode

viewing in Full Screen mode, 23
Function dialog box, 97
functions, 83, 97–98

IF, 99

ScreenTips, 97–98
statistical, 6

G
galleries, 3, 11

Cell Styles, 116
Shape Styles

displaying, 238
grand totals, 95
graphics. See also images; pictures

adding to footers, 171–172
adding to headers, 171–172
worksheets, 234–235, 235

graphs. See charts
gridlines

changing, 140–141
charts

displaying, 219
hiding, 219

colors, 140–141
displaying, 141, 219
hiding, 141
printing worksheets, 159

grouping
columns, 148–149
drawing objects, 246–248
rows, 148–149

groups
adding to Ribbon, 185
cells

deleting, 70
inserting, 70
moving, 70
names, 86–87

worksheets
copying cells to, 77

groups of cells
selecting, 32–33

H
hard shadows, 234
headers

adding graphics to, 171, 171–172
creating, 168–170
formatting, 172
height, 170
previewing, 168
text, 169

headings
printing worksheets, 159, 163

height
footers, 170
headers, 170
rows, 142–143

changing in Page Layout View, 157
Help, 26–27
Help button, 85
hiding

chart legends, 217–218
columns, 35, 75, 150–151
gridlines, 141, 219
grouped columns, 148–149
grouped rows, 148–149
Ribbon elements, 183, 187
rows, 75, 150–151
worksheets, 68

Highlight Changes dialog box, 279
Horizontal scroll bar, 10
hyperlinks, 46–49

adding to files, 46
adding to other files, 47
adding to Web pages, 48
mailto hyperlinks, 49
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I
icons

Ribbon commands, 186
icon sets

displaying, 129
IF function, 99
ignored errors

resetting, 190
images. See also graphics; pictures

editing, 8
reflection, 234

importing
text files, 271, 272
XML spreadsheets, 287

in-cell editing
turning on, 44

Insert Hyperlink dialog box, 48
inserting

cells into worksheets, 70
clip art into worksheets, 251
columns into worksheets, 72–74, 

144–145
comments into cells, 275–276
data into tables, 42
data into worksheets

multiple worksheets, 76–77
dates into cells, 37, 38
diagrams, 252–253
drawing objects into worksheets, 

236–237
hyperlinks, 46–49

into Web pages, 48
mailto hyperlinks, 49
same files, 46
to other files, 47

numbers into cells, 36
pictures into worksheets, 235

rows into worksheets, 72–74, 144–145
shapes

into worksheets, 236
shapes into organization charts, 255
symbols into cells, 45
text into cells, 34–35
text into headers and footers, 169
times into cells, 37, 38
worksheets, 67

Insert Options button, 73
Insert Options indicator, 145
interface (Ribbon), 11

K
Keep Source Column Widths option, 51
Keep Source Formatting option, 51
keyboard shortcuts

navigating worksheets, 31
Keywords field, 17

L
layouts

charts, 214
organization charts, 256

legends (charts), 217–218
adding, 218
removing, 218

libraries
functions, 97–98

Linear Trendline option, 228
line breaks

creating, 34–35, 35
line charts, 212
line sparklines

creating, 229
Linked Picture option, 51
linking, 262–264
links (workbook)

creating formulas, 90–92
list functions, 97–98
lists

custom lists, 200–201
data entry, 40
validation rules, 209

Live Preview
enabling, 11

locking
cells, 153

Long Date format, 110

M
mailto hyperlinks

adding, 49
manual page breaks

setting, 173–174
viewing, 173–174

margins
setting, 164–165

math equations
creating, 8
displaying, 8

maximizing
windows, 21

menus
shortcut

commands, 26–27
Start

opening recently opened workbooks, 13
merging

cells, 132–133
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Microsoft Excel Help, 26–27
Microsoft Office Access 2010

sharing data between Access tables and 
worksheets, 269

Microsoft Office Button. See File tab
Microsoft Office Excel 2010

exiting, 25
sharing data between Access tables and 

worksheets, 269
sharing table data with Word tables, 

265–266
starting, 12

Microsoft Office Excel 2010. See Excel 2010
Microsoft Office Fluent interface, 11

See also Ribbon
Microsoft Office Online site, 27
Microsoft Office PowerPoint 2010

copying Excel charts into, 267–268
Microsoft Office Word 2010

sharing table data with Excel tables, 
265–266

Middle Align button, 119
minimizing

windows, 21
misspellings

checking worksheets for, 59
preventing Excel from turning off 

corrective behavior, 175
mistakes

AutoCorrect
creating entries, 192–193
deleting entries, 194

error messages, 189–191
colors, 191
resetting ignored messages, 190

formulas, 175
model equations

adding to shapes, 258–259

monitoring
formulas, 102–103

mouse pointer
cell styles, 115

Move Down button, 127
Move Up button, 127
moving

cells, 70
columns, 146

worksheets, 72–74
Quick Access Toolbar, 180
rows, 146

worksheets, 72–74
worksheets, 64–65

multicolumn sorts, 199
multiple columns

inserting into worksheets, 145
moving, 74
sizing, 143

multiple rows
inserting into worksheets, 145
moving, 74
sizing, 143

multiple workbooks, 20
viewing, 79

multiple worksheets
formatting, 76–77
inserting data into, 76–77
printing, 158
selecting, 62

N
names

comments, 276
formulas, 88
ranges, 86–87
Ribbon elements, 186

searching for workbooks, 16
tables, 42
workbooks, 24–25
worksheets, 63
worksheet views, 80

navigating
worksheets, 31

New Book option, 66
new features, 5
No Borders option, 51
noncontiguous cells

selecting, 32–33
noncontiguous columns

selecting, 33
noncontiguous rows

selecting, 33
numbers, 211

as text values, 36
formatting, 108–109
inserting into cells, 36

O
objects

customizing, 243–245
drawing, 234–235

adding to worksheets, 236–237
aligning, 246–248
effects, 241
fills, 238–240
grouping, 246–248
ordering, 248
ungrouping, 247

embedding, 262–264
Excel Help system, 26
filling with pictures, 240
linking, 262–264
rotating, 244
rotating in 3-D, 242
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sizing, 243
textures, 239
ungrouping, 247

Office Clipboard, 3
clearing items from, 55
displaying contents of, 54
pasting from, 54

Office.com Web site
finding templates on, 176

opening
workbooks, 13–15

existing workbooks, 14–16
ordering

buttons on Quick Access Toolbar, 180
commands on Ribbon, 182
drawing objects, 248

organization charts, 233
creating, 254–257
design, 257
layouts, 256

Orientation button, 120
orientation (page), 166
orienting

cell contents, 119

P
Page Break Preview mode, 173
page breaks

viewing, 173–174
Page Layout view, 156–157

changing column widths/row heights, 157
page orientation, 166
paper

selecting, 160–161
Paste As Hyperlink option, 51
Paste As Picture option, 268
Paste Link option, 51
Paste option, 51

Paste Preview, 6
Paste Special option, 51
pasting

advanced paste options, 51
cell values, 50–52
from Office Clipboard, 54
Paste Preview, 6

percentages
displaying numerical values as, 108

Pick From Drop-Down List items
displaying, 40

Picture option, 51
pictures. See also graphics; images

adding to worksheets, 235
customizing, 243–245
deleting, 235
editing, 8
filling objects with, 240
removing backgrounds from, 245
rotating, 244
sizing, 243

pie charts, 212, 225
exploded, 226

Portrait orientation
printing worksheets, 166

PowerPoint 2010
copying Excel charts into, 267–268

predefined custom properties, 18
previewing

footers, 168
headers, 168
worksheets, 156–157

print areas
printing parts of worksheets, 162
removing, 162

Print check box, 141
printers

selecting, 160–161

printing
worksheets, 155

creating headers and footers, 
168–170

gridlines, 159
headings, 159, 163
margins, 164–165
multiple worksheets, 158
page orientation, 166
print areas, 162
scale, 166
selecting paper, 160–161
selecting printers, 160–161

proofreading
worksheets, 59

properties
custom properties, 18
finding workbooks, 17–18

protecting
worksheets, 152

publishing
worksheets to Web

dynamically updating, 281
pyramid charts, 212

Q
queries, Web

data refreshes, 284
Quick Access Toolbar, 3

adding commands to, 175, 179–180
adding Ribbon buttons to, 180
customizing, 6
moving, 180
ordering buttons on, 180
removing commands from, 180

Quick Print button, 158
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R
radar charts, 212
ranges

deleting, 87
formatting, 107
formulas

names, 88
names, 86–87
validation rules, 209

recently used files
viewing, 47

redoing
actions, 56

references (formulas), 100–101
reflection

images, 234
Refresh Data When Opening The File 

check box, 284
refreshing

data, 284
links, 92

rejecting
Track Changes, 278–279

relative references, 84
removing. See deleting

advanced filters, 206
backgrounds from pictures, 245
commands from Quick Access Toolbar, 180
Office Clipboard items, 55
print areas, 162
Ribbon elements, 183
splits, 78–79
subtotals, 96
tracer arrows, 101

repeating
headings, 163

replacing
text, 57–58

resizing. See sizing
restoring

Ribbon, 181
windows, 21

retrieving
Web data using Excel, 282–283, 283

reviewing
Track Changes, 278–279

Ribbon, 11
adding buttons to Quick Access Toolbar, 

180
adding commands to, 181
adding groups to, 185
customizing, 6, 181–188
displaying hidden elements, 188
hiding elements, 183, 187
naming elements on, 186
removing elements from, 183
reordering commands on, 182
restoring, 181
tabs

creating, 184
rotating

objects, 244
objects in 3-D, 242
pictures, 244

Row heading, 10
rows, 10

deleting, 72–74, 147
grouping, 148–149
headings

printing, 159
height

changing in Page Layout View, 157
hiding, 75, 150–151

grouped rows, 148–149
inserting, 72–74, 144–145
moving, 72–74, 146

worksheets, 72–74

selecting, 33
sizing, 142
ungrouping, 148–149
unhiding, 75, 151
worksheets

sorting data, 198, 199
rules

AutoFormat, 195
conditional formatting

changing order of conditions, 127
deleting, 125
editing, 124
stopping when conditions are met, 

126
filtering rules

creating, 203
validation rules

creating, 207–209

S
saving

workbooks, 24–25
as XML spreadsheets, 286
to Web, 280

workbooks as templates, 177
worksheets

to Web, 280
scale, 166
scale (charts)

changing
value axis, 220
X-axis, 221

scatter plot charts, 212
scheduling

data refreshes, 284
scientific notation

inserting numbers into cells, 36
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Sort Smallest To Largest button, 198
source data (charts)

changing, 222
spaces

typing formulas, 85
sparklines, 2, 3

creating a column, 230
deleting, 232
formatting, 232
line, 229
summarizing data, 7
Win/Loss

creating, 231
spell checking

worksheets, 59
splits

worksheets, 78–79
splitting

cells, 132–133
SpreadsheetML, 273
starting

Excel 2010, 12
Start menu

opening recently opened workbooks, 
13

statistical functions, 6
status bars, 10
stock charts, 212, 227
stopping

conditional formatting, 126
styles

cells, 115–118
applying, 115
creating, 116
deleting, 118
modifying, 117

charts, 214
copying with Format Painter, 131
diagrams, 253
shapes, 238

ScreenTips
functions, 97–98

scroll bars
Horizontal, 10
Vertical, 10

scrolling
formula bar contents, 34–35

search filters
creating, 204

searching
workbooks, 14–16

security
locking cells, 153
protecting worksheets, 152

selecting
cells, 32–33
columns, 33
printers, 160–161
rows, 33
worksheets, 62, 164

selection filters
creating, 202

series, 29, 39, 213–214
adding to charts, 223
adding trendlines to, 228
deleting, 224

shading
cells, 111, 112

shadows
adding, 241
editing, 241
hard shadows, 234

shapes
adding equations to, 258–259
adding to organization charts, 255
adding to worksheets, 236
styles, 238
text, 237

Shape Styles gallery
displaying, 238

sharing
data, 3
workbooks, 274

comments, 275–276
Track Changes, 277–279

sharing data
between Access tables and worksheets, 

269–270
between Word tables and Excel tables, 

265–266
copying Excel charts into PowerPoint, 

267–268
embedding, 262–264
importing text files, 271, 272
linking, 262–264

Sheet tab, 10
sheet tabs

colors, 69, 139
themes, 139

shortcut keys
navigating worksheets, 31

shortcut menus
commands, 26–27

shortcuts
data entry, 40

Short Date format, 110
showing. See displaying; viewing
sizing

columns, 142–143
objects, 243
pictures, 243
rows, 142
tables, 43
windows, 21

sorting
worksheet data, 198, 199

custom lists, 200–201
Sort Largest To Smallest button, 198
Sort Newest to Oldest button, 198
Sort Oldest To Newest button, 198
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textures, 239
themes

applying, 136–138
colors, changing, 136
creating, 138
sheet tabs, 139

three-dimensional
rotating objects, 242

three-dimensional charts, 226
times

formatting, 30
inserting into cells, 37, 38

titles
charts, 217–218

adding, 218
To Book list, 66
toolbars

Quick Access Toolbar, 3
adding commands to, 175, 179–180
adding Ribbon buttons to, 180
customizing, 6
moving, 180
ordering buttons on, 180
removing commands from, 180

Top Align button, 119
tracer arrows

removing, 101
Track Changes

accepting/rejecting changes, 278–279
Change History

creating, 279
enabling, 277
reviewing, 278–279
viewing, 278–279

Transpose option, 51
trendlines (charts)

adding to data series, 228
troubleshooting

formulas, 102–103

subtotals
creating, 95
removing, 96

SUM formula
creating, 94

summarizing
data

sparklines, 7
statistical functions, 6

summarizing data. See charts
summary worksheets

sparklines, 229–232
summing

cells, 93
AutoSum formula, 94

grand totals, 95
subtotals, 95

surface charts, 212
switching

between workbooks, 20
views, 81

Switch Windows button, 20
symbols

inserting into cells, 45

T
tables

adding data to, 42
columns

creating formulas that reference, 89
sizing, 43

creating, 41–43
creating formulas that reference, 89
names, 42
sharing data between Access tables and 

worksheets, 269
sharing data between Word tables and 

Excel tables, 265–266

sizing, 43
tabs

creating, 184
creating custom groups, 185
creating custom tabs, 184
File, 5, 6

printing worksheets, 158
Ribbon, 10
Sheet, 10
sheet tabs

colors, 139
themes, 139

View
Switch Windows button, 20

worksheets
colors, 69

templates, 3, 175
creating workbooks from, 176
editing, 178
finding on Office.com Web site, 176
saving workbooks as, 177

text
cells, 107

alignment, 119
orienting, 120
wrapping, 120

finding, 57–58
formatting

headers and footers, 169
in shapes, 237

headers and footers, 169
inserting into cells, 34–35
replacing, 57–58
shapes, 237
WordArt

colors, 250
text effects

WordArt, 249
text files

importing, 271, 272
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3D charts, 226
comments, 275
page breaks, 173–174
recently used files, 47
Track Changes, 278–279
worksheets, 62, 78–79

in Full Screen mode, 23
views

Backstage, 2, 6, 156–157
setting print margins, 164–165

Page Layout, 156–157
changing column widths/row heights, 

157
worksheets

custom views, 81
naming, 80
switching, 81

View tab
Switch Windows button, 20

visualizing
data, 7

conditional formats, 7

W
watches, 102

deleting, 103
Watch Window, 102
Web

copying data to Excel, 283
dynamically updating worksheets, 281
Excel Help system, 27
retrieving Web data using Excel, 282
saving workbooks to, 280
saving worksheets to, 280

Web pages
adding hyperlinks to, 48

Web queries
data refreshes, 284

turning on
in-cell editing, 44
Live Preview, 11
Track Changes, 277

typing
AutoCorrect

creating entries, 192–193
numbers as text values, 36

U
undoing

actions, 56
edits to cells, 44

ungrouping
columns and rows, 148–149
objects, 247

unhiding
columns and rows, 75, 151
worksheets, 68

user interface (Ribbon), 11

V
validation

data entry, 207–209
workbooks, 209

value axis
changing chart scale, 220

Values & Number Formatting option, 51
Values option, 51
Values & Source Formatting option, 51
Venn diagrams, 233
Vertical scroll bar, 10
view

Backstage
exiting, 19

View check box, 141
viewing. See also displaying

Web sites
Office.com Web site, finding templates 

on, 176
width

columns, 142–143
changing in Page Layout View, 157

windows
maximizing, 21
minimizing, 21
restoring, 21
sizing, 21

Win/Loss sparklines
creating, 231

Word 2010
sharing table data with Excel tables, 

265–266
WordArt

creating text effects, 249
text colors, 250

words. See also text
finding, 58
replacing, 58

workbooks, 4
backups, 279
blank

starting Excel 2010, 12
cascading, 20
closing, 24–25, 25
creating, 19
creating formulas

cell references, 90–92
table references, 89

displaying, 20
embedding, 262–264
finding, 14–16

file properties, 17–18
hyperlinks, 46–49

adding to other files, 47
adding to Web pages, 48
mailto hyperlinks, 49
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columns, 10
changing width in Page Layout View, 

157
deleting, 72–74, 147
displayed grouped columns, 149
grouping, 148–149
headings, 159, 163
hiding, 35, 75, 150–151
hiding grouped columns, 148–149
inserting, 72–74, 144–145
moving, 72–74, 146
selecting, 33
sizing, 142–143
sorting data, 198, 199
ungrouping, 148–149
unhiding, 75, 151

comments, 4
copying, 66
deleting, 67
displaying, 68
dynamically updating, 281
embedding, 262–264
error messages, 189–191

colors, 191
resetting ignored messages, 190

filtering data
advanced filters, 205–206
AutoFilters, 202–204

footers
adding graphics to, 171–172
creating, 168–170
formatting, 172

formatting, 135
coloring sheet tabs, 139
gridlines, 140–141
multiple worksheets, 76–77
protecting worksheets, 152
sizing columns/rows, 142–143
themes, 136–138

worksheets, 3, 10, 205
adding drawing objects to, 236–237
cells. See cells

accepting/rejecting tracked changes, 
278–279

backgrounds, 111, 112
borders, 113–114
clearing, 53
comments, 275–276, 276
conditional formatting, 121–125
copying from worksheets to groups 

of worksheets, 77
copying values, 50–51
cutting values, 50–51
deleting, 70, 224
dragging, 71
editing, 44
fonts, 106
formatting, 105
formatting parts of, 107
inserting, 70
inserting dates into, 37, 38
inserting numbers into, 36
inserting symbols into, 45
inserting times into, 37, 38
locking, 153
merging, 132–133
moving, 70
numbers, 108–109
orienting contents, 119
pasting values, 50–52
selecting, 32–33
series, 223
shading, 111, 112
splitting, 132–133
styles, 115–118
text, 107
Track Changes, 277

clip art
inserting, 251

workbooks� (continued)
linking, 262–264
links

creating, 90–92
multiple workbooks, 20
opening, 13–15

existing workbooks, 14–16
saving, 24–25

as templates, 177
as XML spreadsheets, 286
to Web, 280

sharing, 274
comments, 275–276
Track Changes, 277–279

switching between, 20
templates, 175

creating workbooks from, 176
editing, 178
finding on Office.com Web site, 176
saving workbooks as, 177

themes
applying, 136–138
colors, 136
creating, 138

Track Changes
accepting/rejecting changes, 278–279
Change History, 279
enabling, 277
reviewing, 278–279
viewing, 278–279

validation, 209
worksheets

copying, 66
deleting, 67
displaying, 68
hiding, 68
inserting, 67
moving, 64–65
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formulas
mistakes, 175

freezing panes, 79
graphics, 234–235, 235
gridlines

colors, 140
displaying, 141
hiding, 141

headers
adding graphics to, 171–172
creating, 168–170
formatting, 172

hiding, 68
inserting, 67
inserting data into

multiple worksheets, 76–77
linking, 262–264
moving, 64–65
names, 63
navigating, 31
page breaks

setting, 173–174
viewing, 173–174

pasting data in
Paste Preview, 6

previewing, 156–157
printing, 155

creating headers and footers, 
168–170

gridlines, 159
headings, 159, 163
margins, 164–165
multiple worksheets, 158
page orientation, 166
print areas, 162
scale, 166
selecting paper, 160–161
selecting printers, 160–161

proofreading, 59
protecting, 152

rows, 10
changing height in Page Layout View, 

157
deleting, 72–74, 147
grouping, 148–149
headings, 159, 163
hiding, 75, 150–151
hiding grouped rows, 148–149
inserting, 72–74, 144–145
moving, 72–74, 146
selecting, 33
sizing, 142
sorting data, 198, 199
ungrouping, 148–149
unhiding, 75, 151

saving
to Web, 280

selecting, 62, 164
shapes

adding, 236
sharing data between Access tables 

and, 269
sorting data, 198, 199

custom lists, 200–201
splits, 78–79
tables

adding data to, 42
columns, 43
creating, 41–43
names, 42
sharing data with Word tables, 

265–266
sizing, 43

tabs
colors, 69

text
finding, 57–58
replacing, 57–58

validation rules
creating, 207–209

viewing, 62, 78–79
in Full Screen mode, 23

views
custom views, 81
naming, 80
switching, 81

worksheet data
creating advanced filters, 205–206

XML, 285
zooming in/out, 22

wrapping
cell text, 120

Wrap Text button, 120

X
X-axis

changing chart scale, 221
XML

code, 285
importing XML spreadsheets, 287
saving workbooks as XML spreadsheets, 

286
SpreadsheetML, 273

XML (Extensible Markup Language), 4

Z
zooming in/out

worksheets, 22
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